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Einleitung

In diesem Dokument wird beschrieben, wie Sie ein Software-Image auf Cisco ASA 5500-
Appliances mit dem Cisco Adaptive Security Device Manager aktualisieren.

Voraussetzungen

Anforderungen

Es gibt keine spezifischen Anforderungen für dieses Dokument.

Verwendete Komponenten

Die Informationen in diesem Dokument basierend auf folgenden Software- und Hardware-
Versionen:

Cisco ASA 5500 und ASA 5500-X 9.1(2) und höher•

Cisco ASDM 7.1 und höher•



Die Informationen in diesem Dokument beziehen sich auf Geräte in einer speziell eingerichteten 
Testumgebung. Alle Geräte, die in diesem Dokument benutzt wurden, begannen mit einer 
gelöschten (Nichterfüllungs) Konfiguration. Wenn Ihr Netzwerk in Betrieb ist, stellen Sie sicher, 
dass Sie die möglichen Auswirkungen aller Befehle kennen.

Verwandte Produkte

Diese Konfiguration kann auch mit der Software Version 9.x der Cisco Security Appliances der 
Serie ASA 5500-X verwendet werden.

Konventionen

Weitere Informationen zu Dokumentkonventionen finden Sie unter Cisco Technical Tips 
Conventions (Technische Tipps von Cisco zu Konventionen).

Software herunterladen

Um die erforderliche Version der ASA Software-Images und ASDM Software-Images 
herunterzuladen, verwenden Sie die folgenden Links:

Cisco ASA Softwareversion herunterladen (nur für registrierte Kunden)•

Cisco ASDM-Softwareversion herunterladen (nur für registrierte Kunden)•

Hinweis: Um diese Software von Cisco.com herunterzuladen, benötigen Sie gültige Cisco-
Benutzeranmeldeinformationen.

Kompatibilität zwischen ASA und ASDM

Der angezeigte Link wurde mit der Kompatibilität und der von Cisco empfohlenen ASDM-Version 
für jede ASA-Version aktualisiert.

ASA- und ASDM-Kompatibilität

ASA-Upgrade-Pfad

Der abgebildete Link enthält den Upgrade-Pfad für ASA. Einige Versionen erfordern ein 
vorläufiges Upgrade, bevor Sie ein Upgrade auf die neueste Version durchführen können.

ASA-Upgrade-Pfad

Upgrade eines ASA Software-Images mithilfe von ASDM 7.x

Gehen Sie wie folgt vor, um ein Software-Image auf der ASA 5500 mithilfe von ASDM zu 
aktualisieren.

https://www.cisco.com/c/de_de/support/docs/dial-access/asynchronous-connections/17016-techtip-conventions.html
https://www.cisco.com/c/de_de/support/docs/dial-access/asynchronous-connections/17016-techtip-conventions.html
https://software.cisco.com/download/home/278875415
https://software.cisco.com/download/home/279513399/type/280775064/release/7.17.1.155
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html#pgfId-121785
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html#id_58680


1. Wenn sich ASA im Einzelkontextmodus befindet, wählen Sie Tools > Upgrade Software from Local 

Computer... aus dem Hauptfenster des ASDM heraus.

 

Wenn ASA im Multiple-Context-Modus ausgeführt wird, Upgrade Software from Local Computer Option 
gemäß Tools ist nur im Systemkontext verfügbar.

 
2. Wählen Sie ASA als Image-Typ, der aus der Dropdown-Liste hochgeladen werden soll.

 



 
3. Klicken Sie Browse Local Files... oder geben Sie den Pfad im Local File Path -Feld, um den Speicherort 
des Software-Images auf dem PC anzugeben. 
 
4. Klicken Sie auf Flash durchsuchen... 
 
5. Es erscheint das Dialogfeld Flash durchsuchen, in dem der Dateiname automatisch eingegeben 
wird. Wenn der Dateiname nicht angezeigt wird, geben Sie ihn manuell in das Feld File Name feld. 
Klicken Sie auf Gut, wenn Sie fertig sind. 
 

 
 
6. Nachdem Sie den lokalen und den Remote-Dateinamen angegeben haben, klicken Sie auf 
Upload Image.

 



 
 
7. Ein Statusfenster wird angezeigt, während ASDM das Bild in den Flash-Speicher schreibt. Nach 
Abschluss des Vorgangs wird ein Informationsfenster angezeigt, das einen erfolgreichen Upload 
anzeigt und fragt, ob das Image als Boot-Image festgelegt werden soll. Auswählen Yes.



Klicken Sie auf OK im Dialogfeld Informationen ein, und klicken Sie dann auf Close im Dialogfeld 
Image von lokalem PC hochladen angezeigt. 

8. Wählen Tools > System Reload aus dem Home-Fenster heraus, um das Gerät neu zu laden.

 
 

Es wird ein neues Fenster angezeigt, in dem die Details des erneuten Ladens überprüft werden. 
Auswählen Save the running configuration at the time of reload und dann eine Zeit zum erneuten Laden 
auswählen. Zur Auswahl stehen Zeitangaben:

Starten Sie das Gerät sofort neu.•
Verzögerung bis - Geben Sie an, wie viele Minuten oder Stunden das Gerät in Zukunft neu 
laden soll.

•

Geplant um - Geben Sie die Uhrzeit und das Datum an, zu der das Gerät neu geladen 
werden soll.

•

 
Geben Sie außerdem an, ob das Gerät ein sofortiges erneutes Laden erzwingen soll, wenn ein 
geplanter Neuladen fehlschlägt. Überprüfen On Reload failure, force an immediate reload after und geben Sie 
dann eine maximale Haltezeit an. Dies ist die Zeitspanne, die die Sicherheits-Appliance darauf 
wartet, andere Subsysteme vor einem Herunterfahren oder Neustart zu benachrichtigen. Nach 
Ablauf dieser Zeit erfolgt ein schnelles (erzwungenes) Herunterfahren/Neustarten. Klicken Sie auf 
Schedule Reload.

 



 
Wenn der Neuladen durchgeführt wurde, wird ein Reload Status wird angezeigt, um anzuzeigen, dass 
ein Neuladen stattfindet. Eine Option zum Beenden von ASDM wird ebenfalls bereitgestellt. 
 

Hinweis: Starten Sie ASDM erneut, nachdem die ASA neu geladen wurde.

 



ASDM-Image mithilfe von ASDM 7.x aktualisieren

Führen Sie diese Schritte aus, um ein Software-Image auf der ASA 5500 mit dem ASDM-Image 
zu aktualisieren.

1. Wählen Sie Tools > Upgrade Software from Local Computer... aus dem Home Fenster des ASDM.

 



 
 
2. Wählen ASDM als der Bildtyp, der aus der Dropdown-Liste hochgeladen werden soll.

 
3. Klicken Sie Browse Local Files...  oder geben Sie den Pfad im Local File Path -Feld, um den Speicherort 
des Software-Images auf dem PC anzugeben.

Klicken Sie auf Browse Flash....

A Browse Flash wird angezeigt, wobei der Dateiname automatisch eingegeben wird. Wenn der 
Dateiname nicht angezeigt wird, geben Sie ihn manuell in das Feld File Name feld. Klicken Sie auf 
 OK wenn sie fertig sind.



 
4. Klicken Sie OK wenn das Image mit dem neuen Image aktualisiert wird.

 
5. Wählen File > Save Running Configuration to Flash aus dem Home Fenster des ASDM.

 



 
Beenden Sie den ASDM, und melden Sie sich erneut an, um die ASA mit dem aktualisierten 
ASDM-Image zu verwalten.

Upgrade von ASA und ASDM mit einem Image Herunterladen 
Direkt von CCO

 
Führen Sie diese Schritte aus, um ein ASA- und ASDM-Image direkt von CCO zu aktualisieren. 
 
1. Wählen Sie Tools > Check for ASA/ASDM Updates... aus dem Home Fenster des ASDM.

 
2. Wenn die Eingabeaufforderung für den Benutzernamen und das Kennwort angezeigt wird, 



geben Sie die Anmeldeinformationen Cisco.com ein, und klicken Sie auf Login.

 
 
3. Die Cisco.com Upgrade Wizard wird angezeigt. Im Overview Abschnitt klicken Next. 
 



 
 
4. Im Select Software -Abschnitt überprüfen, welche Software aktualisiert werden muss. Wenn ein 
Upgrade von ASA und ASDM erforderlich ist, markieren Sie beide Optionen. 
 



 
5. Wählen Sie in der Dropdown-Liste "ASA-Version" die Version aus, auf die das ASA-Upgrade 
durchgeführt werden soll.



 
6. Wählen Sie in der Dropdown-Liste "ASDM-Version" die Version aus, auf die das ASDM-
Upgrade durchgeführt werden soll. Klicken Sie auf Next wenn die entsprechenden Versionen 
ausgewählt wurden.



 
7. Im Review Changes , überprüfen Sie die Änderungen, und klicken Sie auf Next.



 
8. Die Installation der Images beginnt und der Gesamtfortschritt kann wie dargestellt gesehen 
werden. Klicken Sie abschließend auf Finish. 
Im Results Abschnitt überprüfen, Save configuration and reload device now Option. Klicken Sie auf Finish.



 
9. Die Reload Status wird angezeigt, während das Gerät neu geladen wird.



 
10. Klicken Sie Exit ASDM und melden Sie sich erneut an, sobald das Gerät nach dem Neuladen 
wieder verfügbar ist.

CLI zum Aktualisieren eines Software-Images und eines ASDM-
Images verwenden

Ein TFTP-Server ist für das Upgrade oder Downgrade eines Software-Images sowie eines ASDM-
Images für eine ASA erforderlich. Unter TFTP-Serverauswahl und Verwenden finden Sie weitere 
Informationen zur TFTP-Serverauswahl.

Die Fehlermeldung copy tftp flash -Befehl ermöglicht das Herunterladen eines Software-Images in 
den Flash-Speicher der Firewall über TFTP. Verwenden Sie copy tftp flash -Befehls mit einem 
beliebigen Sicherheits-Appliance-Modell. Das heruntergeladene Image kann nun beim nächsten 
Neustart verwendet werden, indem die Boot-Systemvariable so geändert wird, dass sie auf dieses 
Image zeigt.

Dies ist die Ausgabe des copy tftp flash command:

 

https://www.cisco.com/c/de_de/support/docs/routers/10000-series-routers/48700-tftp-server.html


copy tftp[:[[//location] [/tftp_pathname]]] [[flash/disk0][:[image | asdm]]]

 

Führen Sie im Mehrfachkontextmodus diese Schritte im Systemausführungsumfang aus.

Hinweis: Bei ASA ersetzt das Schlüsselwort disk0 den Flash-Speicher im copy aus.

Wenn der Befehl ohne die optionalen Parameter location oder pathname verwendet wird, erhält 
der Benutzer den Speicherort und den Dateinamen interaktiv durch eine Reihe von Fragen, die 
denen der Cisco IOS® Software ähneln. Wenn nur ein Doppelpunkt eingegeben wird, werden die 
Parameter aus dem tftp-server Befehlseinstellungen. Werden weitere optionale Parameter 
angegeben, so werden diese Werte anstelle der zugehörigen tftp-server Befehlseinstellung. Wenn 
Sie einen der optionalen Parameter wie einen Doppelpunkt oder einen beliebigen anderen Wert 
eingeben, wird der Befehl ohne Eingabeaufforderung ausgeführt.

Der Speicherort ist entweder eine IP-Adresse oder ein Name, der mithilfe des 
Namensauflösungsmechanismus der Sicherheits-Appliance in eine IP-Adresse aufgelöst wird. 
Dieser ist derzeit statisch und wird vom name und names -Befehlen. Die Sicherheits-Appliance muss 
anhand der Informationen in der Routing-Tabelle wissen, wie sie diesen Standort erreicht. Diese 
Informationen werden von der IP address,Die Fehlermeldung routeoder die RIP -Befehlen. Dies hängt 
von Ihrer Konfiguration ab.

Der Pfadname kann neben der letzten Komponente des Pfades zur Datei auf dem Server auch 
beliebige Verzeichnisnamen enthalten. Der Pfadname darf keine Leerzeichen enthalten. Wenn ein 
Verzeichnisname Leerzeichen enthält, setzen Sie ihn auf das Verzeichnis auf dem TFTP-Server 
anstatt auf copy tftp flash aus. Wenn Ihr TFTP-Server so konfiguriert ist, dass er auf ein Verzeichnis 
auf dem System zeigt, von dem Sie das Image herunterladen, verwenden Sie nur die IP-Adresse 
des Systems und den Image-Dateinamen. Der TFTP-Server empfängt den Befehl und bestimmt 
den tatsächlichen Speicherort der Datei aus den Informationen im Stammverzeichnis. Der Server 
lädt dann das TFTP-Image auf die Security Appliance herunter.

Diese Befehle werden benötigt, um das Software-Image sowie das ASDM-Image zu aktualisieren 
und es beim nächsten Neuladen als Boot-Image zu erstellen.

 
<#root>

ASA

#copy tftp [[flash:/disk0:][software image name/asdm image name]]

 

!--- Command to set an image as bootup or specify the 

!--- ASDM image file.

 
 
ASA(config)

#boot system [flash:/disk0:]/[software image name]



 

!--- Save active configuration to the Flash.

 
ASA

#write memory

 

!--- Reboot the security appliance and load 

!--- with the new boot image as per the configuration file.

 
ASA

#reload 

 

Beispiel:

 
<#root>

ASA-5512# copy tftp: disk0: 
 
Address or name of remote host []? 172.16.31.1 
Source filename []? asa916-smp-k8.bin 
Destination filename [asa916-smp-k8.bin]? 
Accessing tftp://172.16.31.1/asa916-smp-k8.bin...!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
Writing file disk0:/asa916-smp-k8.bin... 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
38043648 bytes copied in 32.290 secs (1188864 bytes/sec) 
 
ASA-5512# sh disk0 
--#--  --length--  -----date/time------  path 
 

 191  38191104    Nov 21 2014 21:07:48  asa912-smp-k8.bin 

  192  17906032    Apr 08 2015 22:33:44  asdm-713.bin 

  193  26350916    Apr 09 2015 06:28:20  asdm-741.bin 

  194  38043648    May 10 2015 02:14:06  asa916-smp-k8.bin 

 

4118732800 bytes total (3556712448 bytes free) 
 
 

!--- Command to set "asa916-smp-k8.bin" as the boot image.

 
ASA-5512(config)

# boot system disk0:/asa916-smp-k8.bin

 

!--- Command to set "asdm-741.bin" as the ASDM image.



 
ASA-5512(config)

# asdm image disk0:/asdm-741.bin

ASA-5512

# write memory

ASA-5512

# reload 

 

Hinweis: Wenn Sie versuchen, das Image auf der ASA von einem FTP-Server zu 
aktualisieren, verwenden Sie die copy ftp flash aus. Mit diesem Befehl können Parameter wie 
Remote-IP-Adresse und Quelldateiname angegeben werden. Dieses Verfahren ähnelt 
TFTP. Eine Einschränkung besteht jedoch darin, dass Sie die Remote-IP-/Quellschnittstelle 
nicht ändern können (wie dies bei TFTP möglich ist). Im TFTP-Modus werden die Optionen 
mit dem Befehl tftp-server -Kommando aufgerufen und ausgeführt werden. Bei FTP gibt es 
diese Option jedoch nicht. Standardmäßig ist die Quellschnittstelle immer die Außenseite, 
die nicht geändert werden kann. Das heißt, der FTP-Server ist über die externe Schnittstelle 
erreichbar.

Überprüfung

In diesem Abschnitt können Sie überprüfen, ob das Software-Upgrade erfolgreich war.

Der Cisco CLI Analyzer (nur registrierte Kunden) unterstützt show -Befehlen. Verwenden Sie den 
Cisco CLI Analyzer, um eine Analyse der show Befehlsausgabe.

Nachdem die ASA neu geladen und wieder bei ASDM angemeldet wurde, überprüfen Sie die 
Version des Images, die auf dem Gerät ausgeführt wird. Siehe . General auf der Home um diese 
Informationen zu erhalten.

https://cway.cisco.com/cli
http://tools.cisco.com/RPF/register/register.do


Die folgenden CLI-Befehle werden zur Verifizierung des Upgrades verwendet:

Version anzeigen - Zeigt das aktuelle Bild an, mit dem die ASA gestartet wird.1. 
Bootvar anzeigen — Zeigt die Priorität des Bilds an, das nach dem Neuladen verwendet 
werden soll.

2. 

Asdmimage anzeigen — Zeigt das aktuelle ASDM-Image an, das von der ASA verwendet 
wird.

3. 

Fehlerbehebung

Es sind derzeit keine spezifischen Informationen zur Fehlerbehebung für diese Konfiguration 
verfügbar.

Zugehörige Informationen

Versionshinweise•
Cisco ASA Neue Funktionen nach Version•
Cisco ASA-Kompatibilität•
Planung Ihres Upgrades•
Aktualisieren einer Aktiv/Standby-Failover-Konfiguration•

https://www.cisco.com/c/de_de/support/security/asa-5500-series-next-generation-firewalls/products-release-notes-list.html
/content/en/us/td/docs/security/asa/roadmap/asa_new_features.html
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/asa-appliance-asav.html#concept_xxv_yvn_kkb


Informationen zu dieser Übersetzung
Cisco hat dieses Dokument maschinell übersetzen und von einem menschlichen Übersetzer
editieren und korrigieren lassen, um unseren Benutzern auf der ganzen Welt Support-Inhalte
in ihrer eigenen Sprache zu bieten. Bitte beachten Sie, dass selbst die beste maschinelle
Übersetzung nicht so genau ist wie eine von einem professionellen Übersetzer angefertigte.
Cisco Systems, Inc. übernimmt keine Haftung für die Richtigkeit dieser Übersetzungen und
empfiehlt, immer das englische Originaldokument (siehe bereitgestellter Link) heranzuziehen.


